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Software Used 

 

NVivo 1 for Windows (unless otherwise stated) 

 

Files Used 

 

The files used in this study are from the ‘Volunteering Study’ created when NVivo was launched in 

2008. The Volunteering study looks at the motivations people have when doing volunteering work. 

The study was conducted with a sample of adults from Australia and the United States. It consists of 

a range of data (Text, video, audio, pictures, field notes and attributes). 

 

Revision Information 

 

Last revised 2022. This material was created by adapting user guides from Susila Davis (2021, 2018), 

Zainab Kabba (2016), Marie-Hélène Paré (2015) and Chrysanthi Papoutsi (2015). 
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Copyright 

 

 

 

 

 

This document is made available under a Creative Commons Attribution-Non 

Commercial-Share Alike CC-BY-NC-SA license by Marie-Hélène Paré (2015) and 

Chrysanthi Papoutsi (2015), and adapted by Zainab Kabba (2016), Susila Davis 

(2016), Charlotte Albury (2016) and Alexandra Jager (2022) who assert their rights 

to be identified as the authors. 

 

Note that some images and documents used in the presentation and exercises are 

copyright of their owners and may be subject to different copyright conditions. 

Where possible this has been noted in the text. If an error in attribution/copyright 

has been made, please contact the author who will be pleased to make the 

necessary corrections. 

 

For those accessing these materials via the IT Portfolio site, please note that the 

workshop utilizes video content that cannot be distributed in the course materials 

files. The video exercises will work generally with any small audio or video clip, 

however. 

 

Screenshots are copyright of the respective software suppliers. 
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WELCOME TO THE NVIVO 1 
 

Below you will find a few notes on what we will (and will not) do in the workshop, as well as some 

suggestions for revision between the two sessions. 

 

The great thing about NVivo is that QSR provides free tutorial videos and a comprehensive online 

help system. But if you can’t find the answer using NVivo 1’s help system, you may find that the 

help pages for version 11 useful and more comprehensive. In this workshop we will cover some of 

what QSR provides through online videos – but with more detail and specific examples, so take this 

as an opportunity to gain hands-on experience while exploring the software. 

 

We will learn how to do a number of basic tasks that will be useful to most qualitative researchers 

working with data such as interview transcripts, video and audio files, and images. You will have an 

opportunity to work with sample data prepared specifically for the workshop, or you can bring your 

own data and get a head start on your analysis. However, keep in mind that this is not intended as 

a workshop on your project, and the instruction is designed with general skill-building in mind. If 

you would like to work through some of your own data and NVivo project(s), please have a look at 

our NVivo: Data Analysis – Professional Practice course on the ITLC website. 

 

DOWNLOADING NVIVO 
 

NVivo 1 can be downloaded to your laptop, Mac and/or home computer through the Oxford 

University IT registration website (https://register.it.ox.ac.uk). You will have to log in with your 

Single Sign-On and then click on ‘Software’ on the left-hand menu. Next, select NVivo from the list 

of software packages, then, if you’re a Windows user, download either the 64-bit or 32-bit version 

depending on your computer’s RAM (Random Access Memory); or the MacOS version if you’re 

using a Mac. You will then need to click on the Windows and MacOS License Key link (also on the 

registration site above) and enter the license key before you start using NVivo. 

 

You should be aware that the Oxford server version, and the one we will use in the workshop, is 

version 1, while some computers at Oxford still use version 12. As of January 2022, only versions 

12 and 1 are available via the Oxford University IT registration website. The basics of what we cover 

in the workshops will be relevant for any of these. It is possible to open a project created in version 

12 in version 1 – you will receive a prompt to convert your project to the latest version of NVivo 

when you open it, but this will not change the project file itself. Projects created in version 1 cannot 

be opened in version 12. NVivo projects created in versions before 12 can be opened on all later 

versions through a conversion that the software performs. 

 

Lastly, at the end of the workshop we will leave some time to address specific questions from 

participants. The instructors cannot guarantee that they will be able to answer every question on 

NVivo, but if you submit your questions beforehand by email, they will do their best to come 

prepared with an answer. 

  

http://www.youtube.com/user/qsrinternational
http://help-nv11-en.qsrinternational.com/nv11_help.htm
http://help-nv11-en.qsrinternational.com/nv11_help.htm
https://www.it.ox.ac.uk/do/training-and-facilities/itlc-courses
https://register.it.ox.ac.uk/
https://support.microsoft.com/en-gb/help/15056/windows-7-32-64-bit-faq
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/open-a-project-created-in-earlier-version.htm?Highlight=compatibility
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/open-a-project-created-in-earlier-version.htm?Highlight=compatibility
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/open-a-project-created-in-earlier-version.htm?Highlight=compatibility
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/open-a-project-created-in-earlier-version.htm?Highlight=compatibility
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METHODOLOGICAL CONSIDERATIONS 
 

Is NVivo right for you? 
The first question you need to consider before engaging in NVivo-based analysis has to be whether 

or not NVivo will add value to your analysis (or possibly make your life easier). You therefore need 

to think about what you are trying to achieve as a researcher and analyst. Of course, for novice 

users it will be hard to know if NVivo is right, before knowing what it can and can’t do. So, we will 

begin the workshop with a discussion of these issues in light of the participants’ research 

intentions. 

 

NVivo can be quite useful for data sets of various sizes, mixed media and mixed methods data, and 

small or large team research projects through its team-work and cloud server functionality. It has 

broad capabilities and its interface is user-friendly relative to other similar programs. It is becoming 

an industry standard for archiving qualitative data as it is recommended by the UK Data Service, so 

understanding it is worthwhile for researchers who plan on doing Research Council-supported 

projects. It is also free to Oxford students and staff on a site license. 

 

However, it has its limitations and, unlike statistical analysis software for quantitative research, it 

is more ancillary than fundamental as a component of most qualitative projects. At minimum, it is 

worth remembering the following: 

 

- NVivo can do very little analysis for you, and it relies heavily on user input  

- Learning NVivo takes work (this workshop won’t be enough!)  

- Organizing data into NVivo takes more work  

- There may be easier solutions, especially for simple tasks  

- Examining data through NVivo can limit your analytic frame  

- NVivo is known to run slowly or crash, especially on older computers  

 

With these things in mind, there are still lots of good reasons to learn the software and many ways 

it can assist your analysis, help organize your thinking, and keep your data in order. 

 

Before we engage in any data preparation, organization, and analysis, it is worth keeping in mind 

that there are many ways to approach a task in NVivo. The program provides multiple paths to 

fundamentally similar ends. What is important is that your strategy is suited to what you want to 

accomplish with your analysis. 

 

ONE MORE NOTE… 

 

Keep in mind that the following is not an exhaustive list of the approaches to analysis and functions 

available to NVivo users. Instead, the workshop will lay out a few essential skills that will be 

applicable for a wide range of research projects, and hopefully provide participants with the tools 

to self-teach some more intermediate functions. 

  

https://www.ukdataservice.ac.uk/manage-data/document/data-level/qualitative
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READING THE NVIVO INTERFACE 
 

We will just quickly walk through the basics of what you see in your first moments with the 

program. You may want to watch the introductory video later on to revise this on your own 

(although this video is about NVivo 12, the analysis options shown are still available in NVivo 1). 

 

OPENING A NEW PROJECT 
 

When you open the programme, you will see a “welcome” screen that lists all of your recent 

projects on the left-hand side, and has buttons for New Project, and opening sample projects.  

 

 

 
 

When you click on New Project, a dialogue box (1 of 2) will open asking for a project title, file name 

and description for the project. You must enter a project title, which also sets a default file path. 

You can also enter a description of the project, though this is optional, and specify a text content 

language.  

 

 

 

https://www.youtube.com/watch?v=TFj2UCjskt4&index=2&list=PLNjHMRgHS4Fd7g4Q1BQuQgm-gLxy97FqY
http://help-nv10-en.qsrinternational.com/procedures/create_a_new_project.htm
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When you click Next, you will be taken to step 2 of 2. You can customise the settings in step 2 of 2 

to suit your needs, although it is recommended to save your project at regular intervals.  

 

 

 

 

 

INSIDE THE PROJECT 

 

NVivo uses a ribbon-guide menu that looks like this: 

 

 
You will need to import some data before you can start exploring NVivo. The more kinds of data 

you have, the more you can explore the program! 

 

The ribbon-guide buttons each have a roll-over text box providing a description of its function(s). 

This means that when you run the mouse arrow over one of these icons, it will tell you what it 

does. It is a good idea to do this with each button to familiarize yourself with the tools available to 

you. At the outset, the most important tabs and buttons for you will probably be the following: 

 

Home: Once you select an item from a list (or depending on where you are in the NVivo workspace) 
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this tab allows you to code whole data files, run basic queries, generate visualisations and create 

or import classifications. [In NVivo 12, the home tab has a very similar layout]. 

 

Import: This tab allows you to import data prepared elsewhere for NVivo, including Word 

documents, PDFs, transcripts, datasets, audio and video files, classification sheets, academic 

articles and even your reference library. [In NVivo 12, there is an identical ‘import’ tab]. 

 

Create: This tab allows you to create new files of data from scratch, new codes for organization and 

analysis, new cases and classifications, and so on.  

You can create “External” files, which are external data not suitable for importing, such as large 

video files or webpages. You can add notes to describe these, which make them internally 

searchable and codeable. 

In NVivo 1, you can right-click on “externals” in under “Data” in navigation view (far left) or 

alternatively select externals in navigation view and right-click on an empty area in list view and 

select “New External.”  

In NVivo 12, the button for Externals is on the create tab.  

The create functions can all be achieved by right-clicking in a window within the appropriate 

location in your project, but until you know where that is, this tab will provide you with all of the 

one-click shortcuts you need to create data and organize it. 

 

Explore: Here is the full menu to run queries, generate data visualisations and charts, and create 

project maps (such as mind maps). Queries provide ways of seeking specified patterns in your data 

through user-defined parameters. [NVivo 12 also has an “explore” tab]. 

 

Share: This tab allows you to create reports and extracts of your NVivo analyses, export and copy 

your project, print items and export items to save in other applications. [NVivo 12 also has a “share” 

tab].  

 

Modules: This tab allows you to access two services that require payment and a myNVivo account: 

NVivo’s transcription service – you can use the myNVivo portal to buy NVivo 

Transcription subscriptions or pay-as-you-go credits. You must set up an myNVivo account to 

access this. 

NVivo Collaboration Cloud is an NVivo add-on module allowing teams to collaborate on NVivo 

projects using a yearly subscription service that can be purchased from the myNVivo portal. The 

Collaboration Cloud stores NVivo projects on a cloud server, which can facilitate sharing projects 

amongst team members. 

 

You can also add files you have sent to NVivo from Word, Excel or Outlook to the project via the 

“Collect Office Files” button. You must be logged into your myNVivo account to access this. 

 

To transcribe files in NVivo, open a project with audio or video files you wish to have transcribed 

and click “NVivo transcription” on the “Create” tab. NVivo Transcription is a paid service, and 

requires you to be logged into your myNVivo account to access this.  

 

TOP TIP! 
If you’re not sure which ribbon tab to use, right-clicking will usually get you where you need to 

https://portal.mynvivo.com/
https://portal.mynvivo.com/
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go! For example, if you’re looking at a list of documents, and you want to do something to that 

whole item (like copy, or delete it), select the item and then right-click to get a list of options to 

choose from – ‘Copy’ and ‘Delete’ will usually be listed in the right-click options. Or depending on 

what you want to do and where you are in NVivo, left-click in the region where you want to do 

something, e.g. if you’re in a document already, click anywhere in the white space and then right-

click to see what options are given. This will save you having to remember which ribbon tab does 

what. 

 

 

BASIC TERMINOLOGY: DATA, CODES AND CASES 

 

Three essential terms for NVivo skills development are Data, Codes and Cases. 

 

‘Data’ is a term for any research material that you have connected to your NVivo project. This could 

be transcripts or field notes, as well as academic articles, research plans, pictures, audio recordings, 

videos, notes, and online materials. 

 

‘Coding’ is made up of ‘Codes’, ‘Relationships’ and ‘Relationship Types’. A code is best thought of 

as a “container” in which wholes or parts of sources are kept for analysis (note: in NVivo 12 and 

earlier versions of NVivo, codes are called “nodes”). Relationships are connections you can mark 

in your project between two items. For example, one case ‘employs’ another case, or one 

concept (represented by a code) ‘causes’ another concept (a different code). 

 

While NVivo offers users many ways to group and organize their data, codes offer the richest 

avenue for subsequent analysis. This will become clearer as the workshop progresses. 

 

For those who have some familiarity with NVivo 12, please note that the left-hand folder structure 

(navigation view) has a few minor differences in NVivo 1.  

Note: in both screenshots below, the headings in navigation view are “collapsed” i.e. the small 

triangle icons are pointing downwards (NVivo 1) and to the bottom right (NVivo 12).  

  

https://help-nv.qsrinternational.com/12/win/v12.1.55-d3ea61/Content/concepts-strategies/understand-the-key-concepts.htm
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Navigation view: NVivo 12 Navigation view: NVivo 1 
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VIEWING DATA IN YOUR PROJECT 

 

 
 

Once you have ‘Files’ and ‘Codes’ in your project, these will be visible in a List View window when 

you click the Data or Codes buttons on the Navigation View sidebar. If you double-click on a file, it 

will open on the right or below (depending on your settings) in what is called Detail View. 

 

To find files or codes by name, you can quickly bring them up using the Find bar, located above the 

List View window. Simply type in all or part of the name in the Search Project box, and a list of 

relevant items will appear. 

 

To find content within a file, open the file in Detail View and click the Find button under the 

Document tab that appears at the end of the ribbon tabs. 

 

AUTO-SAVING 

 

The NVivo program is set by default to give you reminders to save your project every 15 minutes. 

In version 1, there is a default setting to create a recovery file every 30 minutes (this can be 

customised when the project is first set up). An NVivo recovery file (.nvb) serves as a backup - if the 

standard .nvp project file cannot be opened, you can run the Project Recovery Wizard. If the Wizard 

cannot repair the file, you will be given the option to restore the project from a recovery file. 

 

Your project will not create backup versions of itself automatically, and NVivo is a complex program 

that has been known to crash, potentially ruining hours of work. It is therefore highly 

recommended that you save your NVivo projects regularly and set reminders to do so.  

 

  

 Find Bar 

Navigation 
View 
Sidebar 

 

List 

View 

 

Detail View  
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To save you from this fate, NVivo will present you with this window: 

 

  

 

 

 

 

 

 

By clicking Yes, you will save any changes you have made to the project, which you would then have 

to manually undo.  

 

If you are experimenting with your data, you may want to change the frequency of save reminders 

or turn this function off to avoid unwanted saves. 

 

In NVivo, this can be achieved by going through the following: 

 

File → Options → Notifications tab. 

 

 

 

 

 

 

 

 

 

 

In NVivo 1, go to the File tab, and select ‘Project Properties.’ On the Save and Recovery tab, turn 

on autosaving or set an interval for reminders to save your project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help-nv11.qsrinternational.com/desktop/procedures/save_and_copy_projects.htm
http://help-nv11.qsrinternational.com/desktop/procedures/save_and_copy_projects.htm
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THE NVIVO HELP SYSTEM  
 

NVivo's help system(the small      in the upper right-hand corner) is useful when experimenting 

with NVivo’s functionality or when you run into a problem. The program is massive and in some 

cases not necessarily intuitive. It is, however, very usable if you learn how to learn about it. As 

such, this workshop document has been hyperlinked wherever possible to NVivo’s Help system, 

to encourage you to familiarize yourself with that system. 

 

The most up-to-date version will always be the online help. 

 

NVivo’s terminology can sometimes be confusing. Below you can find a brief glossary of key terms 

linked to the kinds of tasks a qualitative researcher may want to ask NVivo to perform. These are 

not exhaustive, but may assist you in conceiving of Help system queries. 

 
I want to… NVivo equivalent Relevant Help Section(s) (based 

on the online help for NVivo 1 – 

relevant subheadings in 

brackets) 
Bring documents, transcripts, 

datasets, audio or visual material 

into my project 

Import Files Files 

Audio and video 

Surveys and datasets 

Create a document or transcript 

within NVivo 

Create Document 

Transcription (under the ‘modules’ 

tab) 

Files (Documents and PDFs) 

Audio and video 

Include external files or websites 

for analysis 

Create Externals (right-click on 

‘externals’ in navigation view) 

Files (Externals) 

Arrange my data items by type 

(e.g. transcript, article, 

newspaper) 

Create File Classifications Classifications 

Arrange my data items into groups Create a Set (static or dynamic 

set) 

Files (Sets) 

Make a general note to myself or 

other project members 

Create a Memo or Annotations Notes 

Make a specific note about an 

individual project item 

Link a memo Notes (Memos) 

Sort my data into emerging 

themes 

Code file data into codes Coding 

Sort text data into pre-defined 

categories 

Autocode datasets Coding 

Identify demographic information 

for people in my study 

Create case classifications Classifications 

Do content analysis of my text 

data or coded materials 

Run a query using the Query 

Wizard 

Queries 

Review my analysis activities Create or run reports Reports 

 

  

https://support.qsrinternational.com/s/
https://help-nv.qsrinternational.com/20/win/Content/welcome.htm
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GETTING YOUR RESEARCH INTO NVIVO 
 

Before you can do anything meaningful in NVivo, you need to have some data to work with. 

There are two ways to get analysable data in NVivo: import it from external files, or create it 

inside NVivo. 

 

PREPARING AND IMPORTING EXTERNAL DATA (FILES) 
 

Data can be imported into NVivo using the Data tab and selecting the kind of material you want 

to import under the ‘import’ tab: 

 

 
 

NVivo will accept many standard formats for documents, spreadsheets, images, audio, and video 

files. You can import files one at a time or you can bring in entire collections by CTRL-clicking or 

SHIFT-clicking the files you want in the appropriate window. 

 

You can also import Twitter content, webpages, Facebook wall posts and comments, and LinkedIn 

group discussions, by using the NCapture web browser extension. If NCapture is not already 

installed on the version of NVivo you are working with, you can download it here. When you have 

installed and authorised the addition of this extension to your web browser, you will be able to 

capture webpages or social media content by clicking on the NCapture button, usually found on 

the upper right hand corner of your browser. To import the content you have captured in your 

NVivo project, click on the NCapture button in the Import tab. 

 

CREATING DOCUMENTS AND EDITING IMPORTED FILES 

 

You can create documents inside NVivo 1 in the Create tab. NVivo has a limited internal word 

processor suitable for most basic tasks. Formatting tools can be found under the Edit tab (after 

you’ve clicked on the box that says ‘Edit’ in the top left-hand corner of a document (a tick mark will 

appear) of any file in Detail View. 

 

In certain instances, you may need to apply formatting to documents or spreadsheets to make 

them useful in NVivo. Below, we will examine some formatting requirements for Word documents 

and Excel files. In all cases, you will need to ensure that protections (including passwords) are 

removed from documents before they can be opened by NVivo. 

 

If you need to edit a document after you have created or imported it, you can do this by opening 

the file and clicking the Edit button (a tick mark will appear) that appears at the top left of the 

opened document in the Detail View window. Editing an imported file does not affect the original 

external file. 

 

http://help-nv9-en.qsrinternational.com/concepts/about_sources.htm#MiniTOCBookMark4
http://help-nv9-en.qsrinternational.com/concepts/about_sources.htm#MiniTOCBookMark5
https://help-nv.qsrinternational.com/20/win/Content/files/files.htm
http://help-ncapture.qsrinternational.com/desktop/topics/capture_web_pages.htm
https://help-nv.qsrinternational.com/20/win/Content/files/files.htm
https://help-nv.qsrinternational.com/20/win/Content/files/documents-and-pdfs.htm
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If you would like to work with a document file in an external program, you can export the document 

as any of the supported file formats and edit it elsewhere, by selecting the document and clicking 

the Export button under the Share tab. You can alternately right-click the document in the menu 

and select Export. 

 

Remember that if you edit an exported document, you will need to import it again to have the 

edited version available in your NVivo project. 

 

LINKING EXTERNAL DATA (EXTERNAL FILES) 
 

In some instances it will not be possible or wise to import a file into your NVivo project. This will be 

true where the file is very large (which can slow down the program), where it is an online resource, 

or where it is something that could not be opened by NVivo (such as a hard copy of a book or an 

SPSS project). External data can be linked through the ‘Externals’ button under ‘Data’ in navigation 

view: 

 

 
 

Once a file or website has been linked as an external file, a window will open where you can add 

notes, passages, or other text that will be searchable and codable in analysis phases. To access the 

actual file, open the type of external you want to look at in list view, i.e. collapse the ‘Externals’ 

heading in navigation view and double click on either Books, Files or Websites. This will then open 

the selected type of external in list view. You can then right-click on the relevant book, website or 

file in list review and select Open External File, which will take you outside of the program and into 

your external file or website. 

 

https://help-nv.qsrinternational.com/20/win/Content/files/export-files.htm
http://help-nv9-en.qsrinternational.com/procedures/create_externals_for_sources_you_cannot_import.htm
https://help-nv.qsrinternational.com/20/win/Content/files/externals.htm?Highlight=externals
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Do note that, if you link to an external file on a specific computer, you need to be on that computer 

to be able to access that external data. You can also create an external without linking to a file or 

website, by selecting Other under the Type menu in the External tab of the New External dialogue 

box. 

 

ORGANIZING YOUR DATA USING CASES AND CODES 
 

In NVivo 1, there are two types of ‘container’: Codes and Cases. Codes and Cases can be thought 

of as “containers” in which wholes or parts of files are kept for analysis. When importing data into 

your project, it might be useful to start organising your project items by assigning them as themes 

or concepts (Codes), research participants (Person Cases), organisations (Organisation Cases) or 

any other unit of analysis that makes sense in the context of your project. 

 

To create a code or a case, click on the Create tab, and click on Code or Case respectively. You will 

need to name the code or case. If you’re making a code, you can also provide a description of the 

code that will remind you (and project team members, if you have them) what kind of data should 

be placed under that code. You will then manually add data to that code through coding, which we 

deal with in a later section (see ‘Working with codes’). 

 

 
 

When you have imported and organised your data, you will follow the same process to continue 

the analysis by creating thematic codes (or Codes), which capture analytical categories, rather than 

the origin of your files or content. We will cover this in more detail in session 2. 

 

PREPARING TEXT FOR AUTO-CODING 
 

In many cases – especially where you are using NVivo to explore largely unstructured data or to 

hunt for good quotes in a pile of interviews, you will not need to do any document preparation. 

However, for more structured analysis, there are a few key steps that can open up NVivo’s 

capabilities. 

 

It is normally going to be easier to prepare data for importing into NVivo than to manipulate it once 

it has been imported. For most users, it will be preferable to prepare your documents in Word 

format (either .doc or .docx) for subsequent ease of use. In particular, NVivo has been designed to 

recognize Word document heading styles for use in its Auto-Coding functions. 
 

Auto-Coding allows the researcher to quickly aggregate text information through previously-

assigned categories. A normal way to use this function would be in instances where a structured 

interview or questionnaire has been administered as part of a study, and the researcher wants to 

aggregate all answers to a particular question from multiple respondents. Auto-coding can also be 

used to separate individual speakers out of group interviews, as well as more creatively to organize 

https://help-nv.qsrinternational.com/20/win/Content/coding/coding.htm
https://help-nv.qsrinternational.com/20/win/Content/cases/cases.htm
http://help-nv9-en.qsrinternational.com/procedures/automatic_coding_in_document_sources.htm
https://help-nv.qsrinternational.com/20/win/Content/nodes/create-theme-node-automatically.htm
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semi- or un-structured pieces of data. 

 

For this to be possible, categories in all files must be arranged under headings that are exactly the 

same, and from these headings, NVivo will be able to separate and collect these responses into 

analogous categories as codes in your project. 

 

PRECISION IS ESSENTIAL! 

 

NVivo does not make decisions or corrections for you, and small errors in text or format can 

complicate or negate your use of import functions and other automatic processes in NVivo. For 

example, if you want to auto-code interview responses, a small typo – including an extra space or 

punctuation in the heading line – can result in a response being left out of the appropriate code. 

 

You should therefore design strategies at the front end to minimize the chance for errors, such as 

developing templates for transcripts or quality-checking transcripts prepared by yourself and 

others. 

 

ORGANIZING YOUR DATA USING CLASSIFICATIONS 
 

Once you have imported your data, it is time to organize it for analysis (recognizing that for many 

researchers, organization and analysis are sometimes concurrent and sometimes in opposition!). 

As noted earlier, your organization choices will be specific to the kinds of analysis you want to 

perform. 

 

CLASSIFICATIONS AND ATTRIBUTES 
 

Classifications provide a way of arranging and rearranging files and cases for analysis. Attributes 

provide ways of subdividing and refining classifications by adding numeric or text values to a 

classified file or case. 

 

File classifications allow the researcher to organize their data sources by type. Case classifications 

provide a similar function for cases, and case classification attributes allow more complex queries 

in analysis stages. We will explore some of the standard approaches to file and case classification. 

 

CREATING FILE CLASSIFICATIONS 

 

File classifications can be created under the Create tab by clicking File Classification and following 

subsequent instructions. The NVivo program comes with a number of pre-defined file classification 

options, and users may also define their own classifications. 

 

Users may then add attributes to each classification. You can add attributes to the classification by 

clicking File Classifications button in Navigation View, right-clicking on the classification you want 

to specify, and selecting New Attribute. 

As always, refer to the relevant help section if you get stuck. 

  

https://help-nv.qsrinternational.com/20/win/Content/classifications/about-classifications.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/about-classifications.htm
http://help-nv9-en.qsrinternational.com/procedures/create_source_classifications.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/create-file-classifications.htm
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 CREATING CASE CLASSIFICATIONS 

 

The process for creating case classifications is the same as for file classifications described above, 

substituting “case” for “file” in each instance. 

 

It may be useful for you to add demographic information regarding participants, or other details 

about files, places, people, incidents, experiences, or any other aspect of your project.  

 

You can use a case classification to create a case, for example, to separate responses of individual 

participants or to assemble all data from a particular location or organization into single codes. 

When considering your classification and attribute structure, think about categories that will be 

helpful in separating your data. A common structure for a case classification used for demographic 

details can be found here, but there are many ways to approach this problem. 

 

Classifying cases will give you increased analytic abilities. For example, you may want to be able to 

know how many people over 40 years of age answered a question in a certain way or how often 

participants from a certain geographic area mentioned a specific idea or term. This is best achieved 

through using case classifications and attributes. The thought process behind this task is rather 

complicated to explain in text, so in the workshop we will do this through an exercise instead. 

Please feel free to consult the relevant help section for further clarification. 

 

IMPORTING CLASSIFICATION SHEETS THROUGH EXCEL 

 

You can prepare classification sheets for importation into NVivo. This is particularly handy if you 

have already collected your data in another program prior to using NVivo. A classification sheet in 

Excel should have the following format before importing: 

 

 

 

 

 

 

 

You can also import tab-separated text files if that is more suitable to your data. 

 

Once you have a properly-formatted classification sheet, you can import it through the Import tab 

by clicking on the Classifications button, which will then give you the option to Import Classification 

Sheets. 

 

  
 

 

http://help-nv9-en.qsrinternational.com/procedures/create_node_classifications.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/create-case-classifications.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/classification-sheets.htm
http://help-nv9-en.qsrinternational.com/procedures/import_(or_export)_classification_sheets.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/create-case-classifications.htm
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This will open the Import Classification Sheets wizard, which will guide you through the process: 

 

 

Refer to the help sections if you get stuck, and make sure your source file (the Excel file) is not open 

on your computer when you try to import it. 

 

EDITING CLASSIFICATIONS 

 

All classifications, attributes, and attribute values can be subsequently edited if the categories you 

want to use change during analysis. The NVivo program will maintain files or codes included under 

an old classification or attribute in the re-named version. It will also offer you the opportunity to 

re-assign and add values if you change your attribute value structure, so with a bit of care you 

should be able to painlessly re-name and re-structure classifications as often as necessary. 

 

CUSTOMIZING YOUR INTERFACE 
 

If you decide to use NVivo for your project, you will spend many hours in front of it. Customizing 

can make this experience more pleasant and productive. There are a number of small changes you 

can make to the layout of NVivo to suit your personal working style and preferences. The following 

are some of the basic options you may want to know about. 

 

 THE RIBBON GUIDE 

 

As noted above, NVivo uses a ribbon-guide menu system rather than drop-down lists. If you want 

to maximize screen space, you can right-click an empty space on the ribbon (i.e. the area in the red 

circle below) and select MinimizeRibbon: 

 

 
 

Alternatively, you can double-click on any ribbon tab (e.g. the tab Import or Create) to hide the 

ribbon icons, for the following layout: 

 

http://help-nv9-en.qsrinternational.com/procedures/manage_classifications.htm
https://help-nv.qsrinternational.com/20/win/Content/classifications/classification-sheets.htm
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The ribbon can be opened up again temporarily by single-clicking a tab, or permanently by double-

clicking any of the tabs. 

 

 SIDEBARS 

 

To further maximize screen space, the Navigation View sidebar, and the Find or Search Project 

toolbar can be hidden. To achieve this, select Workspace on the Home tab and then select the 

option “Dashboard Mode.” To reverse this, select Workspace and then click on “open” (this will 

re-open the navigation view).  

  

 

 

 

DOCKING WINDOWS 

 

Once you have imported data into your project, you will want to open data files to read, code and 

otherwise analyse them. You have the option of opening these in your project window (“docked”) 

or in a separate window (“undocked.”). When you open a file, the standard way it is displayed will 

be docked, as shown below: 
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Docked 

  
 

To undock a file, you can either click on Workspace on the Home tab and select “undock” (note: 

you must first click on the open file names, as shown below, e.g. “Grace” or “Ken” for this option 

to appear) , or click the icon in the top right of the Detail View , or right-click on one of the 

open file names below (e.g. “Grace” or “test”) which will give you an option to “undock.” 
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Undocked 

  
 

 

ANALYSIS 
 

Once you have some or all of your data imported or linked to your NVivo project, and hopefully 

have it at least somewhat organized, you are in a position to begin analysing it. In the second 

session, we will look at some of the tools that can assist you in reading your data, recording insights, 

linking pieces of data together, and sorting relevant findings into themes. 

 

This workshop is not a substitute for qualitative research training. Achieving results through NVivo 

begins and ends with solid ideas about what qualitative data analysis can do and what you want to 

accomplish in your project. NVivo can help keep large data sets organized, structure your thinking 

about certain questions, and provide means to creatively explore your data. It cannot tell you what 

your data says about your research problem, and in almost all cases you will still have to read (or 

watch, or listen to, or otherwise examine) your data carefully before drawing conclusions. 

 

WORKING WITH CODES 
 

 

A LITTLE MORE ABOUT CODES… 

 

In the second session we created people codes through manual coding and auto-coding. In these 

instances, each code represented a pre-defined category for information. However, many forms of 

qualitative inquiry rely on inductive approaches, where categories for data analysis emerge after 

data collection is completed. In this sense, codes can also be understood as thematic categories, 
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and can be created during analysis. Sorting your data into codes through manual coding can be as 

structured or unstructured as is appropriate to your research method. 

 

 PARENT CODES AND CHILD CODES 
 

When you start to think about creating codes, you may want to develop a coding hierarchy. For 

example, if a theme emerges that is very general, and you want to sub-divide elements of that 

theme when sorting data through coding, you can create a parent code for the broader theme and 

child codes for the specific sub-themes. To create a child code, right-click on one of your existing 

codes and select New Code from the drop-down list. The new code will be created as a child of the 

selected code, which then becomes the parent. 

  

If you want all of the data coded to child codes to be available in detail view when you view the 

content of the parent code, click the Aggregate coding from children box when creating a parent 

code. If you want to enable this function after the code has been created, open up the Code 

Properties box (by right-clicking on the relevant code) and select Aggregate coding from children.  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://help-nv.qsrinternational.com/20/win/Content/nodes/aggregate-nodes.htm
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 REORGANISING CODES 

 

Parent and child codes can be re-organized as the project progresses. They can be moved between 

different levels of hierarchy and assigned to new parent codes where appropriate. You can re-

organize using drag-and-drop, cut-and-paste, or merge functions. You can re-name codes, create 

new codes from multiple old codes, and re-code files and data as you see fit. Your coding structure 

can therefore be as fluid or rigid as you like. 

 

 CODING TEXT 

When you are examining your data, you may see a passage or quote in a text file that you think is 

important to your analysis. To record that passage or quote and store it in the appropriate code, 

simply select the text you want with the mouse cursor. Each coded selection is called a 

“reference”. You can then place that reference in an existing code by selecting Code under the 

Home tab, selecting “code selection”, and then selecting the appropriate code in the dialogue 

box: 

 

  
 

You can click on Create New to create a code from scratch using the dialogue box, and code your 

reference to that new code. 

 

You can also code at existing codes by right-clicking the selected text, and selecting Code Selection 

and the relevant code from the menu that appears; by using drag-and-drop coding, dragging the 

https://help-nv.qsrinternational.com/20/win/Content/nodes/reorder-organize-nodes.htm
https://help-nv.qsrinternational.com/20/win/Content/coding/coding-techniques.htm
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highlighted text from the Detail View window to the code in the List View window; or by using the 

quick-coding toolbar, which can normally be found at the bottom of the NVivo interface and looks 

like this: 

 
 

Finally, you can code “In Vivo”, which means that the selected text will become the name of a new 

code that will be instantly created. This is a useful function when you come across a key phrase or 

term that you expect to see repeated in other files. You can do this by highlighting a passage, right-

clicking on your selection and selecting Code In Vivo, or by pressing CTRL+F8. 

 

Keep in mind that you can code any piece of data at an unlimited number of codes, so do not worry 

if you think a passage is relevant to multiple areas of your project. You can make it a reference in 

as many codes as you like. However, when you want to query your data later, having one piece of 

text in multiple codes might become a problem to analyse efficiently. 

 

 VIEWING CODES IN DETAIL VIEW 

 

 All data coded to a code will then be available when you open up that code in the detail view. 

Codes can be viewed in three ways, under separate tabs found on the right-hand side of the open 

code while in detail view. These are: 

 

 

- Summary: Shows you a list view of all files coded at that code  

 

- Reference: Shows linking and percent coverage of coding at each code  

 

- Dataset: Combines Summary and Reference views  

 

 

Under the Reference and Text tabs, you will see a hyperlink to that file that you can click to take 

you directly into the place in the file that holds the specific piece of data. You will also be able to 

see how many references were coded from that file to the code and how much of the file is covered 

by each reference. 
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If you want to see your reference in context, you can also use the Spread Coding function in the 

Code tab - to see a text on either side of the selection. The Code tab appears when you open a 

code. 

 

 
 

The coding spread can be made for a custom range, and may be particularly useful if you prefer to 

code key words rather than whole passages. 

 

 CODING WHOLE FILES 

 

You can also code whole files to codes by selecting a file (or multiple files) in list view and then 

clicking Code → Code Whole Files in the Home tab. 

 

UNCODING 

 

If you change your coding structure or no longer think something is relevant to a certain code, 

you can remove coding from references or parts of references coded in a file. You can uncode a 

reference through the Home tab, or by selecting the passage you want to uncode, right-clicking 

and selecting Uncode at the relevant code, or by switching on Coding Stripes (in the Document 

tab that opens when you open a File), and then right-clicking on the coding stripe you are 

interested in and clicking on ‘Uncode’. 

 

 CODING AUDIO AND VISUAL MEDIA 

 

You can use most of the same coding techniques on audio and video that you use with text. If you 

have an audio or video file inside your project, you can open it in NVivo. It will create a waveform 

representing the audio file. You can click-and-drag your mouse cursor over sections of the 

waveform and code them as if they were text. 

 

As with text files, when viewing audio or video references in the code in Detail View, you will see 

how much of the file is covered by the reference. You will also be given a hyperlink to the selection. 

Clicking on the link will open up the audio or video file and take you to the beginning of the 

reference, which you can then play through the NVivo media player. 

 

You can also code image files. This is done by click-and-dragging your mouse cursor over the area 

of a picture that you would like to code, and then coding appropriately. You can add descriptive 

text to picture files, and this can be coded like regular text. 

 

AUDIO AND VIDEO TRANSCRIPTS 

 

Here you have two options. The first one is using NVivo’s automated transcription function in the 

https://help-nv.qsrinternational.com/20/win/Content/coding/remove-coding.htm
https://help-nv.qsrinternational.com/20/win/Content/files/audio-and-videos.htm
https://help-nv.qsrinternational.com/12/win/v12.1.110-d3ea61/Content/files/pictures.htm
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The Normal Mode (left 

triangle icon) works with the 

audio/video and the transcript 

as separate items. 

The Transcribe Mode (right 

triangle icon) enters a new 

row in the transcript area 

with its associated timespan. 

The Synchronize Mode (middle triangle icon) 

coordinates the audio/video with the transcript. 

‘Modules’ tab – where NVivo ‘reads’ your data automatically and produces an instant text 

transcription – which will be uploaded to your myNVivo portal. There are two things to be aware 

of here. Firstly, NVivo Transcription uses cloud functionality – i.e. your audio/video file and 

transcription document will be automatically uploaded to NVivo’s Cloud or the myNVivo portal – 

in order for NVivo to be able to ‘read’ your data. You must make sure that using an external cloud 

facility like this does not violate any Ethics and Data Protection protocols that you are following 

for your research project (particularly for projects involving sensitive or personal data). Secondly, 

you have to check if you’ve purchased ‘transcription minutes’ for NVivo to transcribe your file – 

you can do this in your myNVivo portal page. Or if you’ve already purchased minutes previously, 

you may not have sufficient minutes for your particular file – for example, you may have only 10 

minutes remaining but your file may be 60 minutes long. You can purchase extra minutes in 

myNVivo. [Please note that these minutes ‘expire’ after a period of time if unused.] After you’ve 

sorted out your minutes, when you click on a File that requires transcribing (like a video or an 

audio file), you can then click on ‘Modules’ and then ‘Transcription’. You will then be directed to 

log in to myNVivo if you haven’t already. Once you’re back in your NVivo project, you will see the 

following window: 

 

 
 

The column with the number shows the duration (number of minutes) of the file. You can then 

select the transcription language and press Transcribe. You can then pick up your transcription in 

myNVivo and then import it into your NVivo project. Please remember to delete your audio or 

video file and transcription from your myNVivo portal, particularly if you are analysing sensitive 

data.  

 

The second option is using NVivo’s media player, where you can manually listen to or watch your 

media file and then type up or create a transcript using the program’s transcription functions. 

 

Using the different options of the Play Mode three transcriptions options are possible. 

 

 

 

 

 

 

  

https://help-nv.qsrinternational.com/12/win/v12.1.55-d3ea61/Content/files/create-audio-or-video-transcripts.htm?Highlight=create%20transcript
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You can also import a transcript, and if your transcripts are prepared with appropriate timestamps 

you will be able to use NVivo’s transcript synchronization functions. These will allow you to read 

through a transcript in sync while its audio or video file is playing. It also lets you code references 

from transcript text and have these linked in the node to your audio file as well. 

 

VISUAL MARKERS OF CODING 

 

You may want to be able to see how much of a file has been coded, and where. NVivo thus gives 

you the ability to add Highlighting and Coding Stripes to either some or all of your codes. 

Highlighting will highlight the text in the file to show where coding has occurred, while coding 

stripes provide a visual representation in a new sidebar. Adding coding stripes will also show you 

Coding Density, which reveals you how many times a particular reference has been coded at 

separate codes. 

 

To add coding stripes or highlighting, open a file, then go to the Document tab and select Highlight 

or Coding Stripes. From the drop-down menu that appears, select the codes you would like to 

visualize. These can be turned on and off as necessary. 

 

 

https://help-nv.qsrinternational.com/12/win/v12.1.55-d3ea61/Content/files/import-audio-video-transcripts.htm
https://help-nv.qsrinternational.com/20/win/Content/coding/highlight-coding.htm
https://help-nv.qsrinternational.com/20/win/Content/coding/coding-stripes.htm
https://help-nv.qsrinternational.com/20/win/Content/coding/coding-stripes.htm
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CREATING A CODEBOOK 

 

You can use a codebook to record definitions of your codes, capture how your coding has evolved, 

present representative examples of your coding, or even document exclusion and inclusion criteria 

for the content that should be coded under a specific code. A codebook captures the intended 

meaning for each of the codes so that these can be applied as consistently as possible through time 

and between different members of the research team. 

 

You can attach definitions to each of your codes by right-clicking on them in List View, then 

choosing Code Properties and adding a definition to the Description box. 

 

To create a codebook, you would then need to run a report that lists the codes and their 

descriptions. Under the Share tab, choose New Formatted Report and then select New Formatted 

Report via Wizard. A new window will open where you will need to choose the option From a View: 

Code. In the next screen expand the menu under Code and choose the fields you would like to 

include in your report (in this case Name and Description). Click Next until you are asked to name 

your report. You will then be able to view the codebook under the option Reports in the Navigation 

View sidebar. 

 

Alternatively, you can download a codebook template and import it in your project (in the Import 

tab).  

 

 

QUERYING DATA 
 

Alongside sorting your data into codes, you can run a number of processes to learn more about 

what is in your data. We have already examined auto-coding, and there are a number of other tools 

that may provide insight into text-based and coded files. You can run queries for all of your project, 

or for a selected group of files, codes, sets, folders, and/or annotations and memos. All of the query 

functions can be found under the Explore tab. 
 

 
 

 

WORD FREQUENCY SEARCHES 

 

You can find out how many times a specific word or group of related words can be found in all of 

your data, or in a selected part of it. To find the most common words in your data, you can run a 

Word Frequency Query. This is the most basic query function, and will query selected text files in 

https://help-nv.qsrinternational.com/12/win/v12.1.55-d3ea61/Content/about-nvivo/whats-new.htm?Highlight=code%20book
http://help-nv11.qsrinternational.com/desktop/procedures/run_a_word_frequency_query.htm
https://help-nv.qsrinternational.com/20/win/Content/queries/word-frequency-query.htm
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your project for the most frequent words. You can specify how many words you would like to see 

as well as a minimum length, to avoid words like “I”, “a” and “the”. 

 

To run a word frequency query, select Word Frequency under the Explore tab, set your parameters 

and click  on the top right corner of the dialogue box. You will see that the program 

creates your results in detail view under four tabs on the right-hand side: Summary, Word Cloud, 

Tree Map, and Cluster Analysis. Each of these provides a different way of visualizing your query. 

 

 

TEXT SEARCHES 

 

Text searches provide another way to determine how often certain words appear in your data and 

annotations. You can also use a text search to find out how many times a certain word appears in 

context with another word or phrase. 

 

To run a text search, select Text Search under the Explore tab and enter the word or phrase you 

would like to find in the Search for section of the dialogue box. You can specify your search further 

by looking for exact matches or similar phrases, and you can also limit your search to within 

selected areas of your project. 

 

You can also add special instructions within the text box by clicking the button on the 

right-hand side of the box. These allow you to add Boolean modifiers to your query, as well as 

specify other words that should be nearby by clicking the Near option. This can help narrow your 

search significantly in a large dataset. 

 

Once you have set your parameters, click  in the top right-hand corner. Like viewing a 

code in detail view, a Text Search Query creates Summary, Reference, and Dataset sections. Also 

like coding, you can spread your text search coding (via the “spread to” option before running the 

text search query) so that surrounding text is included in detail view. 

 

Running a text search query will also create a Word Tree, which shows you a visual representation 

of words that occur near the text you are seeking. 

 

CODING QUERIES 

 

If you want to look in more detail at the coding you have done, you can run a coding query. These 

allow you to examine coding within a single code to see what kinds of patterns may emerge. You 

can look for content coded at a specific code, cross-referenced with another code or set of codes, 

files, searches, classifications, and so on. This is a way of looking for overlap between categories, 

as well as specifying results within categories. 

To run a coding query you can either use the Query Wizard or create one outside the Wizard using 

the Coding button in the Explore tab.  

 

QUERY WIZARD 

 

On the Explore tab, click on Query Wizard. Choose the type of query you want to run in the dialogue 

https://help-nv.qsrinternational.com/20/win/Content/queries/text-search-query.htm
https://help-nv.qsrinternational.com/20/win/Content/queries/coding-query.htm
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box. You can select one of four options: see where particular terms occur in content, identify 

frequently occurring terms in content, search for content based on how it is coded, or cross-

tabulate how content is coded.  

Click on Next and follow the steps in the Wizard. In step 3 of 4, you will be given the option to select 

the items you would like to search in: all files in your project, selected items (particular codes, files 

etc.) or items in selected folders (files, externals, memos etc). 

You can also choose in step 4 whether to run the query once or save the query to your project so 

you can run it again if you wish. 

  
 

USING THE CODING FUNCTION 

 

In the Explore tab, click on Query and then Coding. A new blank query will open in Detail View.  

You will be given the option to select the items you would like to search in: all files in your project, 

selected items (particular codes, ‘Data’ etc) or items in selected folders (Files, Externals, Memos 

etc). 

By default, the query will search using All the criteria specified. If you would like the search to meet 

only some if your criteria, select Any. 

You can choose to find content that is coded at, or not coded at: All Selected Codes or Cases, Any 

Selected Code or Case, or Any Case Where (cases with specific attribute values). To add more 

criteria, click on the + button on the right-hand side. This will add a new row to your search criteria.  

Click the Run Query button or Run and Save Results. 
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COMPOUND QUERIES 

 

Compound queries allow you to combine a text search query with a coding query, or to combine 

two text search queries to look for overlap. All of the parameter rules remain fundamentally the 

same as with individual text search and coding queries, but in compound queries you get to refine 

your search with proximity modifiers, i.e. by looking for only those references that occur near, with, 

or not with or near, another set of references. You can find this option by going to the Explore tab, 

selecting Queries and then selecting Compound. 

 

  
 

SAVING QUERIES 

 

If you want query results to be available to you again in the future, you can click the Save Results 

button located at the top of any query dialogue box. Or you can save the actual Query itself and 

the criteria you’ve applied by clicking on Save Criteria. This will save the query under the Queries 

section in the navigation view. 

https://help-nv.qsrinternational.com/20/win/Content/queries/compound-query.htm
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You can save queries under Codes or Sets by clicking the Save Results button in the top right of the 

query tab and following the instructions in the dialogue box, which will look like this: 

  
 

If you choose to create a code or set rather than merge the results with an existing code or set, this 

will show up in the Query Results folder under Queries, which can be found under Explore in 

Navigation View. Note that you cannot code new content at a code created through a query until 

it has been added to your other codes by cutting and pasting the code from the Results folder to 

an appropriate location in your code hierarchy. 

 

LINKS: MEMOS, ANNOTATIONS, SEE ALSO LINKS, AND HYPERLINKING 
 

There are a number of ways to link data in your NVivo project to the ideas and bits of writing that 

emerge while doing your analysis. Memos and annotations provide ways to create new, searchable 

and codable text that can contain ideas about how data should be used, analytical insights, notes 

to research team members, or reminders about research tasks still to be done. See also links allow 

you to connect related files between one another within the project, and hyperlinking allows you 

to connect to web-based information. Linking in some instances may be preferable to coding, 

especially where ideas connecting these pieces of data are in formative stages. Memos, 

Annotations and See Also Links are stored under Notes in the Navigation View sidebar. 

 

 MEMOS 

 

A memo is basically a document source or note that holds some conceptual thinking rather than 

data. You can create a memo under the Create tab or import one from a supported document 

format. You can then link the memo to a single file or code, or specific content within these via the 

Home tab. To do so, select the item you want to link to a memo (e.g. a specific code or file), click 

on Item in the Home tab and select either “link to new memo” or “link to existing memo.”  

 

Selecting Link to New Memo will create a new memo and automatically link it to the selected file 

or code. Memo links can later be deleted by selecting Delete Memo Link. 

https://help-nv.qsrinternational.com/20/win/Content/queries/manage-query-results.htm
http://help-nv9-en.qsrinternational.com/procedures/create_or_import_memos.htm
https://help-nv.qsrinternational.com/20/win/Content/notes/memos.htm
https://help-nv.qsrinternational.com/20/win/Content/notes/memos.htm
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You can also create a memo containing general thoughts and leave it unlinked. Memos are stored 

under Notes in the Memos folder, and they can be viewed, searched, coded, and classified just like 

any other document file. 

 

 ANNOTATIONS 
 

Like memos, annotations serve to record some thinking about a piece of data. Annotations are 

created within a file by highlighting the relevant section of the file in Detail View (e.g. if you have a 

document open, there will be a tab at the top far right called “Document”) with the mouse arrow 

and selecting the text you wish to mark with an annotation, and then on the ribbon tab for the 

open file selecting New Annotation. Any piece of data that can be coded can also be annotated. 

You can annotate text files as well as pdfs, images, and audio and video files. You can add 

annotations within a file as many times as you like. 

 

 

 

 

Once you have created an annotation, it will appear whenever you open that file in a window below 

the detail view. If you code the annotated passage to a code, the annotation window will also 

appear when you open the code in detail view.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://help-nv.qsrinternational.com/20/win/Content/notes/annotations.htm
https://help-nv.qsrinternational.com/20/win/Content/notes/annotations.htm
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You can hide annotations from Detail View by unchecking the “Annotations” option in the 

Document tab. This can also be achieved in an open file by clicking on the button at the top-left of 

a file circled below, which will then give you the option to select or unselect “view annotations”: 

 
You can also delete annotations from directly from the Detail View. Alternately, you can delete 

them by highlighting the annotated text, right-clicking and selecting Delete Annotation or delete 

them from the Annotations folder in the navigation view under Notes. 

 

 SEE ALSO LINKS 
 

See Also Links connect related material within your project. They can be used to connect files, 

codes, and specific content within those. They can also be used to create new files that are 

automatically linked to the selected content. To create a See Also Link, highlight the relevant 

section of file data and click See Also Link in the Document tab. As with annotations, a See Also Link 

can be created for any data that can be coded. 

 

 
 

 

SETS 
 

Sets are another way of organizing files and codes into groups for subsequent analysis. Sets are a 

kind of Search, and Search folders are handy because they can contain both files and codes at the 

same time, and can be searched using NVivo’s query functions. 

 

To create a set, go to the Create tab and click on Static Set (manually selected project items) or 

Dynamic Set (consisting of project items that upon opening the set meet criteria defined for each 

set). Name your set, describe it if you wish, and then click OK. You can then add any code or file to 

your set by right-clicking the item and selecting Add to Static Set from the menu that appears. 
 

 
 

  

https://help-nv.qsrinternational.com/20/win/Content/notes/links.htm
https://help-nv.qsrinternational.com/20/win/Content/files/sets.htm
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HYPERLINKING 

 

If you want to connect your data to web-based files, NVivo provides a hyperlinking function. To add 

a hyperlink, you must first be in edit mode. Then, simply highlight the selected text, click Hyperlink 

under the Edit tab (this is in the very top right-hand corner), and insert the URL. You can also 

hyperlink to a file path within your computer. Note that hyperlinks can only be added to text files. 

 

IMPORTING REFERENCE LIBRARIES 
 

You can add your reference or bibliographic data to your project, which will make it subsequently 

searchable. For example, if you have a large EndNote, Zotero or Refworks library with lots of linked 

files, notes, or URLs, bringing these into your project is relatively easy and gives you the ability to 

analyse your literature alongside your data. 

 

To import a library, click Bibliography under the Import tab and select the appropriate software 

package from the drop-down menu. 

  
Select the appropriate file and follow the instructions, referring to the help sections if you get stuck. 

Once you have successfully imported your library, each reference will appear as a new External file. 

 

You can also elect to have attached files added as project Files; to have URLs imported along with 

the reference as external files; and to have any information entered under the “Notes” sections of 

your library included as new memos in your NVivo project. 

 

Each type of file you import will also create a file classification and attributes. Classifications are 

examined in the next section. If you make future amendments or additions to your reference 

library, not to worry. Just repeat the steps above, and NVivo will recognize pre-existing references, 

amended references, and new references, and process each accordingly. The changes you make 

should be updated without duplicating references or files. 

 

OTHER AREAS OF INTEREST 
 

As noted at the outset, this has been an introductory workshop to a very large program. Below 

are some signposts to intermediate functions that you can explore after the workshop if you 

wish.  

 

FRAMEWORK MATRICES 

 

Framework matrices allow you to summarise large volumes of information across cases and 

themes, so that you can create an overview of the content of your materials and look at the 

differences between individuals, organisations or other units of analysis. A typical framework 

https://help-nv.qsrinternational.com/20/win/Content/notes/links.htm
https://help-nv.qsrinternational.com/20/win/Content/notes/links.htm
http://help-nv9-en.qsrinternational.com/procedures/exchange_data_between_nvivo_and_reference_management_tools.htm
https://help-nv.qsrinternational.com/20/win/Content/files/reference-management.htm
http://help-nv10.qsrinternational.com/desktop/procedures/create_and_change_framework_matrices.htm
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matrix would look like the one illustrated below, with rows for case codes and columns for thematic 

codes: 

 

 

 

 

 

 

 

 

 

 

To create a framework matrix, select the option Framework Matrix, under the Create tab. Name 

your matrix in the dialog box that opens. Under Rows, select the cases that you would like to include 

as rows in your matrix. Under Columns, select the thematic codes you would like to display as 

columns. Optionally, under Row Header Attributes you can select characteristics of your case codes 

(e.g. age, gender etc.), which will be included in the matrix. 

 

PREPARING SURVEY RESULTS AND OTHER DATASETS 
 

You can import datasets including survey results and demographic information in much the way 

you would import classification sheets. NVivo provides a number of avenues for analysing datasets. 

You can filter, sort and auto-code dataset content (including analysis by demographic fields), code 

text fields to codes, and link these results to the rest of your project. While the workshop will not 

deal directly with dataset creation or importation, it is worth knowing that this function exists if 

you are working with datasets in your research. 

Keep in mind that NVivo is not designed for sophisticated analysis of dataset results such as 

regression testing, and you cannot produce tables or graphs from your dataset. You also cannot 

edit your dataset once it has been imported into NVivo. 

 

RELATIONSHIPS 
 

You can define relationships linking different components of your project. This function is found 

under codes in navigation view and is a form of coding. These can remind you and your project 

team that certain participants know one another, are related, work together, and so on. They can 

also chart things like birthplace, timelines within the research or regarding events discussed in the 

project, and organizational relationships as well. 

 

MAPS  
 

You can create visual representations of various aspects of your project. These might include 

relationships, coding structures, and many other dynamic aspects of your analysis. You can also 

build static maps or models from scratch using the relatively simple and user-friendly modelling 

tools. Once you have made a map, you can export it for use in other programs. 

 

While the maps generated in NVivo can look like social networks, neither the relationship codes 

http://help-nv9-en.qsrinternational.com/concepts/about_dataset_sources.htm#MiniTOCBookMark5
https://help-nv.qsrinternational.com/20/win/Content/files/datasets.htm
http://help-nv9-en.qsrinternational.com/concepts/about_relationships.htm
https://help-nv.qsrinternational.com/20/win/Content/nodes/relationships.htm
https://help-nv.qsrinternational.com/20/win/Content/vizualizations/maps.htm
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nor the modelling features are a substitute for Social Network Analysis (SNA) software. 

 

NVIVO REPORTS AND METHODOLOGICAL TRANSPARENCY 
 

NVivo offers Reports functions, which can create automatic outputs charting your coding activities, 

code structure, classifications, as in the example of the codebook we created in session 2. These 

reports can be generated at the click of a button, or you can specify parameters for your reports if 

you want to look at specific bits of work or the activity of specific team members. For some (but 

not all) qualitative social scientists, it will be important to be able to provide an account of how you 

did your analysis and arrived at your conclusions. Reports can be helpful to this end. You can also 

review the article by Bringer et al (2004), which is an early examination of the ways in which NVivo-

based analysis can be articulated to others for transparency purposes. 
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http://help-nv9-en.qsrinternational.com/concepts/about_reports_and_extracts.htm
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/reports-extracts.htm
http://qrj.sagepub.com/content/4/2/247
http://download.qsrinternational.com/Document/NVivo11/11.3.0/en-US/NVivo11-Getting-Started-Guide-Pro-edition.pdf
http://download.qsrinternational.com/Document/NVivo11/11.3.0/en-US/NVivo11-Getting-Started-Guide-Pro-edition.pdf


NVIVO 1 for Windows 
 

42 

 

EXTRA RESOURCES 
 

Using NVivo  

 

• YouTube tutorials on NVivo:  

http://www.youtube.com/user/QSRInternational  

 

• Practical support, training and information:  

http://caqdas.soc.surrey.ac.uk  

 

• Bazeley, Patricia, and Kristi Jackson, eds (2013). Qualitative data analysis with NVivo. London, 

Sage.  

 

• Guidelines on managing and documenting qualitative data:  

https://www.ukdataservice.ac.uk/manage-data  

 

• Learning qualitative analysis on the Web – _using software:  

http://onlineqda.hud.ac.uk/Intro_CAQDAS/index.php 

 

• Using NVivo to work in a team/Collaborating using NVivo: 
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/nvivo-

collaboration.htm 

 

• Dendogram analysis: 

https://ncss-wpengine.netdna-ssl.com/wp-

content/themes/ncss/pdf/Procedures/NCSS/Hierarchical_Clustering-Dendrograms.pdf 

 

• Analysing surveys, preparing survey data before import, and importing survey data: 
https://help-nv.qsrinternational.com/20/win/Content/files/datasets.htm 

 

• Preparing survey data before import, and importing survey data (previous version of NVivo 
but uses same principles): 
https://help-nv.qsrinternational.com/12/win/v12.1.96-d3ea61/Content/files/datasets.htm  

 

• Video on surveys (previous version of NVivo but uses same principles): 
https://www.youtube.com/watch?v=sFIdkSjWE48 

 

Interpreting and making sense of qualitative data 
 

• Braun, V. and Clarke, V. (2013) Successful Qualitative Research, London, Sage. Chapters 8-11  

 

• Becker, H. (1998) Tricks of the Trade: How to Think about Your Research While You're Doing It 

 

• Berelson, B. (1952). Content Analysis in Communication Research. Glencoe: THE FREE PRESS. 

 

http://www.youtube.com/user/QSRInternational
http://caqdas.soc.surrey.ac.uk/
https://www.ukdataservice.ac.uk/manage-data
http://onlineqda.hud.ac.uk/Intro_CAQDAS/index.php
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/nvivo-collaboration.htm
https://help-nv.qsrinternational.com/20/win/Content/projects-teamwork/nvivo-collaboration.htm
https://ncss-wpengine.netdna-ssl.com/wp-content/themes/ncss/pdf/Procedures/NCSS/Hierarchical_Clustering-Dendrograms.pdf
https://ncss-wpengine.netdna-ssl.com/wp-content/themes/ncss/pdf/Procedures/NCSS/Hierarchical_Clustering-Dendrograms.pdf
https://help-nv.qsrinternational.com/20/win/Content/files/datasets.htm
https://help-nv.qsrinternational.com/12/win/v12.1.96-d3ea61/Content/files/datasets.htm
https://www.youtube.com/watch?v=sFIdkSjWE48
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NVivo for Mac help sites and video tutorials 

 

• NVivo for Mac help site - https://help-

nv.qsrinternational.com/20/mac/Content/welcome.htm  

 

• NVivo for Mac – getting started guide - https://help-

nv.qsrinternational.com/20/mac/Content/tutorials/nvivo-tutorials.htm  

 

• NVivo for Mac – case classifications and demographic data - https://help-

nv.qsrinternational.com/20/mac/Content/classifications/about-classifications.htm  
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• NVivo for Mac – autocoding in data sets - https://help-

nv.qsrinternational.com/20/mac/Content/coding/automatic-coding-

datasets.htm?Highlight=autocoding 

 

• NVivo for Mac – create cases automatically - https://help-

nv.qsrinternational.com/20/mac/Content/cases/create-cases-automatically.htm  

 

• YouTube videos: autocoding for Mac (previous version of NVivo for Mac but uses same 

principles) - https://www.youtube.com/watch?v=8RqR0NCZjss&t=9s  

 

• Classifications for Mac (previous version of NVivo for Mac but uses same principles) - 

https://www.youtube.com/watch?v=j1UNE6KPRtQ&t=4s  

 

 

Course Packs 
 

• (Shorter) Introductory online course: https://skills.it.ox.ac.uk/nvivo-walking-before-

running-code-and-retrieve-course-pack 

 

• Full Introductory (in-person) course: https://skills.it.ox.ac.uk/nvivo-up-and-running-

course-pack 
 

 

  

https://www.youtube.com/watch?v=8RqR0NCZjss&t=9s
https://www.youtube.com/watch?v=j1UNE6KPRtQ&t=4s
https://skills.it.ox.ac.uk/nvivo-walking-before-running-code-and-retrieve-course-pack
https://skills.it.ox.ac.uk/nvivo-walking-before-running-code-and-retrieve-course-pack
https://skills.it.ox.ac.uk/nvivo-up-and-running-course-pack
https://skills.it.ox.ac.uk/nvivo-up-and-running-course-pack
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Dr Susila Davis, Alex Jager & Dr Charlotte Albury

NVivo 1 for Windows – Walking before 

Running: Code and Retrieve



Take a moment to check you have everything you need.

Have you got your:

1) Course slides

2) NVivo v1 installed with Licence Key enabled

3) Work files/data provided for this session

4) Something to write with, and write on

We are working with data 

that should already be on 

your computer.

Have you saved this 

somewhere easy to find?



3

• Navigate your way round NVivo

• Import text data into NVivo

• Code text data

• Make notes about your data

• Retrieve coded data using ‘queries’

Learning objectives -

Today you will find out how to:
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FIRST THINGS FIRST…

WELCOME!

Today you’re with Susie and Charlotte.

Online teaching is not as straightforward as teaching in-person. 
You’re in safe hands, but sometimes the online environment may 
make the class more ‘exciting’. Please bear with us.

If your computer has a problem (for example with your  internet 
connection, or other software) this is not something we can help 
with. 

This is a Windows course, but we will do our best to 
signpost or handle Mac-related queries within the time we 
have – your slides include extra tips/instructions.

! Mac 
users

https://skills.it.ox.ac.uk/files/itlcpda034slidesnvivowalkingbeforerunningpdf


PRACTICAL WORK

Exercises for you to practise today & materials are all in 

the ITLC Portfolio for downloading

https://skills.it.ox.ac.uk/nvivo-walking-before-running-

code-and-retrieve-course-pack

• There's two of us 

to help you

• You can ask 

questions by 

raising your hand 

in Teams, or use 

the chat

https://skills.it.ox.ac.uk/nvivo-walking-before-running-code-and-retrieve-course-pack


WHAT IS NVIVO?

NVivo is a Computer Assisted Qualitative Data Analysis 
(CAQDAS) software package.

Closeness to data – at least as much as can be had using 
manual methods – is assisted by enlarged and improved 
screen display, improved management of and access to 
multiple sources and types of data, rapid retrieval of coded 
text and easy ability to view retrieved segments of text in their 
original context. (Bazeley and Jackson, 2013).

Helps people manage, shape and make sense of 
unstructured information. It doesn't do the thinking for you; it 
provides a workspace and tools to enable you to easily work 
through your information.’ (QSRinternational.com)
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WHAT IS NVIVO NOT?

 Your data analysis

 An approach to data analysis

 A method of data analysis

 Something that tells you how to do your analysis

 Something that tells you when you’ve come across   

interesting findings

11
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WHAT VERSION, WHAT COMPUTER, 

WHAT’S HAPPENING?

▪ Different versions of NVivo (11, 12 and ‘release 1’ [not 13!])

▪ We will be demonstrating using NVivo v1 for Windows

▪ If you don’t have NVivo 1 for Windows things may look a little 

different… You can open an older version file in newer 

version software but NOT the other way round… [NVivo will 

prompt you]

▪ NVivo for Mac and Windows are different – NVivo for Mac 

generally has less functionality than Windows.

▪ On the Mac, you can do most of what we are showing you today, 

but may have to press slightly different buttons

▪ There is a Windows-Mac Project Converter, but beware of 

converting too many times…

! Mac 
users
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Write down in the Chat some 

different ways or reasons why 

you might need to be 

cautious when using software 

to analyse qualitative data in 

your field.

USING 
SOFTWARE: 
CAUTION…



WORKING WITH QUALITATIVE DATA

Import

Explore

Code

QueryReflect

Visualise

Memo

14

▪ Take some time to step 
away from the data.

▪ Save project files on your 
computer and a flash 
drive/secure hard drive.

▪ Try to work backwards from 
what you plan to achieve 
with your data analysis and 
research



THE NVIVO WORKSPACE

List view: displays content of folders Detail view: shows the sources

Navigation 

view
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RIBBON TABS

Top tip

If in doubt, 

right-click 

wherever 

you are, 

see 

available 

options!

Running queries and visualisation functions

Creating documents, memos, codes and classifications

Navigation, coding and classifications

Importing files and project items

16



HELP SYSTEM

17

Help from earlier versions like NVivo 11 and 12 = also good



If you’re not sure…

18

RIGHT-CLICK in a white space



TIME TO PRACTICE!



Task 1: Create a new Project

i. Open NVivo and click on the ‘New Project’ button.

ii. Leave the ‘Keep a log of user actions’ box unchecked.

iii. Fill in a Project title, eg. Volunteering. Set the Text content 

language.

iv. Review the options Step 2 and click on ‘Create Project’.

Task 2: Review the NVivo Workspace

i. Locate the Navigation view sidebar section. 

ii. Click on different sections.

iii. Review the changes in the list view of the workspace.

EXERCISE 1: Create an 

NVivo Project

20



KEY ELEMENTS: DATA

‘Data’ is where many of the materials 

connected to your NVivo project will 

be stored. In Data you can store data 

in three types of folders: Files, File 

Classifications, and Externals. 

Folders

Noun project: Carla Dias

1. Files: data you import or create in 

NVivo (eg. PDFs, transcripts, audio).

2. File Classifications: ‘labels’ with 

descriptive information assigned to 

Files (e.g. bibliographic information)

3. Externals: links to data you can’t 

import in NVivo (eg. Websites, 

books).

C
re

a
ti
ve

 S
ta

ll

Dominic White

C
hr

is
 G

re
g
o
ry

Files

Wilson Joseph

Externals

Author:

Title:

Year:

Publisher:

…

File classifications

TODAY

21



Task 1: Import Interviews

i. Create a new folder in Files, name it Interviews.

ii. Click on the Import tab > click Files > Locate the 9 files 

(in ‘Interviews’ > ‘Participant files’).

iii. Leave the box that says ‘Create a case for each 

imported file’ unchecked for now. We will create the 

Cases later.

iv. Click ‘Import’.

EXERCISE 2: Import Files -

Word Documents

22

Check out your Workbook for instructions on importing other types of files ☺



KEY ELEMENTS: NOTES
‘Notes’ is where you can store ideas you 
might have about your project, or things 
you might normally scribble in your 
fieldnotes. In Notes you can store data in 
four types of folders: Memos, Framework 
Matrices, Annotations and See Also Links.

1. Memos: notes and reflections about 

your project.

2. Annotations: notes about a specific 

section of a project item, phrase or 

marking content for follow-up.

3. Framework Matrices: tables for 

summarizing data about  cases and 

 themes. Beware the word limit…

4. See Also Links: marking if a project 

item or section of text might be 

related to another

Memos

Framework 

matrices

TODAY
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EXERCISE 3: Create a Record 

of  Work (a Memo)

▪ Memos can be created for any purpose: what you observe 

during fieldwork, impressions you are left with after an 

interview, content of your coding protocol, strategies for 

analysis, etc.

Create Memos

i. In Notes, highlight the Memos folder > right click in list view > 

select New Memo > name new memo: NVivo course

ii. Create a memo listing the things you have learned thus far.

iii. Create another memo listing your remaining questions.

24



EXERCISE 4:

Creating an Annotation

25

▪ Annotations are useful for sections of text that you are not sure 

what to do with yet, but you want to make a note or comment 

about. Be aware that annotations are not ‘searchable’, 

whereas memos are.

Highlight some text that you’re not sure how to code yet, 

right-click, and select New Annotation. Write some text to 

reflect ideas you might have for a future code you might 

create later. (Annotations are equivalent to Comments in 

Word or PDF documents)

! Mac users: In Detail View, select the content you want to annotate. In the 
context menu, select New Annotation (or keyboard shortcut Shift+⌘+A).



WHAT DATA DO YOU THINK 

YOU CAN PUT INTO 

NVIVO?
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DATA SOURCES



Interviews/

focus groups

Video files

References

Online data 

(e.g. Twitter, 

Facebook, 

webs, etc.)

Audio files

Memos 

(i.e. your own 

thoughts) DATA SOURCES

Pictures

Check out your Workbook for more details on NVivo’s functionality ☺



Break time…



KEY ELEMENTS: CODES

Codes: ‘containers’ in which wholes or 
parts of sources are kept for analysis.

1. Codes: identified patterns & 
themes (according to data, lit. 
review)

2. Relationships: a type of code that 
defines the connection between 
two project items

3. Relationship types: Different kinds 
of connection available between 
project items

Noun Project | Jars Alex Auda Samora; Person – Stefan Parnarov; Institution – Phil Buchanan

Time

LifeWork

Codes

Sunil is 

‘associated 

with’ Code 

‘Life’

FredricAnna

Anna 

‘employs’ 

Fredric

Relationships

TODAY
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TYPES OF CODING
Coding: the analytical process through which data is fractured, 
conceptualized, and integrated to form theory. (Strauss & 
Corbin)

▪ Deductive Coding

o Codes used by other researches

o Codes developed from literature review/extant theories

▪ Inductive Coding

o Codes developed from raw data

▪ Hybrid Approach

o Deductive & inductive coding

Characteristics of a good code: label; definition; descriptive 
(how/when occurs & any qualifications/exclusions)

*
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CODES & CODING IN NVIVO

▪ Codes are used to identify a theme, a person, a place, a 
case, etc.

▪ Codes can be organized into hierarchies from a general topic 
(parent code) to specific topics (child codes).

▪ Approaches:

1. Manual coding: codes are created based on selected 
content in the data.

2. Auto-Coding questions: a code is created for each 
question and contains all the answers. (Ideal when working 
with structured data.)

3. Running text queries: a code is created based on the 
results of text searches that retrieve the occurrences of a 
word in the data. (Ideal when the literature review is used 
to generate codes.)

*
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CODING TEXT

▪ Coding at new codes

Select the text > Home or Document tabs > code 

selection at new code

▪ Coding “in vivo”

Select the text  > Home or Document tabs > Code 

In Vivo

▪ Uncoding

Select the text > Home or Document tabs > 

Uncode selection

*
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EXERCISE 5a:

Manual coding: basic, ‘in vivo’ & recent

Exploring what you’ve imported

i. Go into one of your Interview Files – e.g. Anna. Have a look at the 

interview. What structural features do you notice about that File – how are 

the questions and responses arranged and formatted?

ii. What kinds of Codes can you create by inductively coding your Interview 

File? Highlight the text you want to code, right-click and select Code 

Selection. Under Create New, select Top-level Code. Type a name for that 

code that reflects what you have highlighted. Click on OK. Open the Code 

you’ve just created and explore its content.

iii. Using the right-click method, code something ‘In Vivo’ or using ‘Code to 

recent codes’.

34

! Mac users: Select your text in Detail view, go to the Home tab, in the Code menu, 
in Code Selection, click ‘To New Code’, or right-click [Ctrl+click] to see your options. 



EXERCISE 5b:

Manual Coding – dragging & dropping

Create Thematic Codes

i. Create a folder in the Codes area called Theme.

ii. Go to your ‘Interviews’ folder and open the Interview with Grace.

iii. Read the first passage of Grace. She’s talking about ‘doing family 

activities’. Create a code about the notion of Family activities.

iv. Select, drag & drop Grace’s answer to the code Family activities.

v. Review Mary’s answers and code at the same code. (highlight, 

drag & drop).

vi. Create another code called, ‘Elderly home’ and code some text.

35



EXERCISE 6: Visual Markers 

of  Coding

Task 1: Visualize Codes Using Coding Stripes

i. Open any Interview file > go to the ribbon > in the 

Document tab > click on the icon Coding Stripes > 

select Recently Coded.

ii. Coloured stripes appear on the right side of the Detail 

View.

Task 2: Visualize Codes Using Highlight

i. Document tab > Highlight > Select the Codes you 

would like to visualize.
36

! Mac users: Open a file in Detail View. In the View menu, select ‘Coding Stripes’.



Demo: Auto-Coding –

Question codes

i. Create a folder called Questions in the Codes section.

ii. Go to Files > click on the Interviews folder > select the 9 

interviews > right click > click on Auto Code.

iii. In the Auto Code Wizard – Select ‘Code by paragraph styles’.

Step 1: Select Heading 1 and Heading 2, then  the ‘>>’ button 

> Next > Step 2: at the option Under, change to Existing folder

> at the option Name, select Questions folder > OK > Finish.

iv. Review codes in the Questions folder.
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! Mac users: Auto-coding of Word files is not available on NVivo for 
Mac, but you can auto-code Excel files. Search ‘Autocode datasets’ in 
the Help menu.

https://help-nv.qsrinternational.com/20/mac/Content/coding/automatic-coding-datasets.htm?Highlight=autocoding
https://help-nv.qsrinternational.com/20/mac/Content/welcome.htm


KEY ELEMENTS: CASES
‘Cases’ is where the units of analysis 

and their ‘labels’ connected to your 

NVivo project will be stored. In Cases 

you can store data in two types of 

folders: Cases, and Case 

Classifications.

1. Cases: units of analysis from the data 

(respondent, institution, country) that 

can be ‘coded’ to project items.

2. Case Classifications: ‘labels’ with 

descriptive information assigned to 

demographic, institutional, or 

geographical data about cases. 

Noun Project | Jars Alex Auda Samora; Person – Stefan Parnarov; Institution – Phil Buchanan; 

Demographics Nithinan Tatah

Cases

Anna Phoebe

World Bank

TODAY

Case 

classifications

Age:

Job:

Gender:

…
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Demo: Auto-Coding - Cases

i. We are now going to create a case for each interview participant.

Return to Files > click on the Interviews folder > select the 9 interviews 

> right click > click on Auto Code again.

ii. In the Auto Code Wizard – Select ‘Code by speaker name’.

iii. Enter all the speaker names – use the ‘Preview’ menu to help you –

make sure the spellings are correct. [The names you will input are: 

Anna, Ben, Bernadette, Fredric, Grace, Ken, Mary, Nick, Phoebe, Sunil]

iv.Click Next when you’re done.

v. Next to ‘Create new classification’, type ‘Respondents’. Click Finish.

vi.You’ll see that a Case has been created for each interview respondent.
39

! Mac users: Create cases from interviews by going to List View, select all your 
interview files > on the Home tab, click ‘Organise’ > ‘Create as Cases’. Then in 
the ‘Classification’ menu, in List view, select your cases and choose a 
Classification. Search ‘Set up cases from interviews’ in the Help menu.

https://help-nv.qsrinternational.com/20/mac/Content/cases/create-cases-automatically.htm#Setupcasesfrominterviews
https://help-nv.qsrinternational.com/20/mac/Content/welcome.htm


CLASSIFICATIONS
▪ Classifications are descriptive information you assign to 

sources or codes.

▪ This information can be used to classify your sources or 

codes by groups which are called Sets.

▪ File classifications are used to store bibliographic 

information about your data.

▪ Case classifications are used to store demographic, 

institutional, or geographical data about case codes.

▪ Your Classification data can be imported from Excel or txt.

▪ If you work with a small number of cases and with few 

attributes, you may want to create a case classification 

directly in NVivo.

*
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Demo: Case Classifications

Task 1: Import Case Classification from Excel

i. Go to the Case Classifications folder > right click in List View > 

click Import Case Classification Sheet. 

ii. In the Wizard step 1 > locate the Case Classification Sheet file 

in the Volunteering Data on your computer 

iii. In Step 3, click the option As names. In the Select location 

window > highlight the folder Cases > OK > Next > Finish.

Task 2: Check that your Cases are classified as ‘Respondents’

i. Go to Cases > select all cases > right click > go down to 

Classification, is ‘Respondents’ selected?
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! Mac users: Use the ‘.csv’ file to Import your Case Classification sheet, not
the ‘.xlsx’ file.



An example scenario to recap 

everything you’ve just done…



Anna

NVivo: What can I learn about Anna?

43Noun Project | Book - Alice Cerconi; Paper - Creative Stall

WorkTime

Field notes about 

whole research 

project

Video of 

interview with 

Anna Interview 

transcription with 

Anna

Text coded to ‘Work’

Text coded to ‘Time’

Memo about Anna

Text coded to Work

Interview 

transcribed

Typed up 

field notes 

• All data 

referenced to 

Case = Anna

• All data coded 

at Codes 

‘Work’ and 

‘Time’

• Connection 

between 

Codes ‘Work’ 

and ‘Time’ via 

Anna

Code Case = ‘Anna’ to 

(section of) field notes



HOW CAN YOU EXPLORE 

YOUR DATA AFTER CODING 

AT CODES?

You may retrieve all the data relating to a specific person or a 
certain topic in your study.

Use of  timeAnna 



HOW CAN YOU EXPLORE 

YOUR DATA AFTER CODING 

AT CODES?
Using more advanced functionality You may search for content by 
one informant on a particular issue.

Use of  

timeAnna

This is called a ‘coding query’ and there's a step-by-step video here:

https://www.youtube.com/watch?v=Gh2orDf1O9A



RUNNING QUERIES
▪ Word frequency queries identify the most frequently 

occurring words (or sets of similar words around a 
concept).

▪ Text search queries identify all references to a word or 
phrase, also looking for similar words (useful for quick 
coding).

▪ Coding queries look for content coded at selected 
codes, a combination of codes, or a combination of 
codes and attributes.

▪ Compound queries combine text search and coding 
queries, text searches where one term precedes the 
other or two coding queries when content coded at 
one code is near content coded at another.

*
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EXERCISE 7: Word 

Frequency Searches

i. In the Explore tab > Word Frequency > Set 

parameters > Run Query.

ii. Examine the Word Cloud, Tree Map, and 

Cluster Analysis on the right-hand side of your 

screen.

iii. Re-try your search but eliminate shorter words 

or move the Finding Matches bar from Exact to 

Similar.
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Check out your Workbook for more details on NVivo’s functionality ☺



EXERCISE 8:

Text Searches
i. In the Explore tab > Text search > Insert: volunteer > Run Query.

ii. Review results in Detail View; Word Tree Tab

iii. Try the same word with an asterisk at the end: volunteer* and see 

the difference in results

iv. Try using the Special instructions button on the right to narrow your 

search:

o Asterisk (*) as a substitute for zero or more characters.

o Question mark (?) as a substitute for a single character.

o Use “” marks for phrases

o You can use Boolean operators AND, OR, NOT or + (required)

o Fuzz search: ‘color~’ will find ‘colors’ or ‘colour’

o Specify proximity: “happy busy” ~102

48
Check out your Workbook for more details on NVivo’s functionality ☺



EXERCISE 9: Creating a 

Codebook
i. Under the Share tab > New Formatted Report (via the Wizard).

ii. Select the option From a view: Code.

iii. Expand the submenu under Code.

iv. Choose Name and Description fields and move to right column.

v. Continue clicking Next. 

vi. Name your report Volunteering Codebook.

vii. Finish.
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! Mac users: On the Share tab, in the Export menu, select ‘Export 
Codebook’. (Optional: Select which code folders you want to see.) Click 
‘Select’, make any necessary changes (e.g. the format of the codebook), 
then click ‘OK’.



Demo: Matrix Query

The Matrix Query looks for content coded a pair of items and displays 

the results in a table.

Run a Matrix Query

i. Go to Explore > Matrix Coding Query.

ii. In the Matrix Criteria section > in Rows > click on the        > click 

Select Items. 

iii. In the Select Project Items window > highlight the folder Case 

Classification > click on +sign of Age group > tick all values from 

20-29 to 60+. (Do not tick Unassigned & Not Applicable.) > OK.
50

! All users: Don’t worry if your query doesn’t show any results – it could be 
that your case classification import hasn’t worked. You can practise more 
in NVivo sample projects provided by QSR International: search for 

‘sample projects’ in NVivo Help online (or click here for Windows and Mac)

https://help-nv.qsrinternational.com/20/win/Content/about-nvivo/explore-sample-project.htm
https://help-nv.qsrinternational.com/20/mac/Content/about-nvivo/explore-sample-project.htm


Demo: Matrix Query 

(cont’d)

Run a Matrix Query (cont’d)

i. In Columns > click on the        > click Select Items. 

ii. In the Select Project Items window > click on Codes on the left.

iii. On the right, tick all codes > OK.

iv. Click Run. 

By default, the matrix displays the number of coded references for 

each pair of items. 
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Check out your Workbook for more details on NVivo’s functionality ☺

! All users: Don’t worry if your query doesn’t show any results – it could be that your 
case classification import hasn’t worked. You can practise more in NVivo sample 
projects provided by QSR International: search for ‘sample projects’ in NVivo Help 

online (or click here for Windows and Mac)

https://help-nv.qsrinternational.com/20/win/Content/about-nvivo/explore-sample-project.htm
https://help-nv.qsrinternational.com/20/mac/Content/about-nvivo/explore-sample-project.htm


THINKING AHEAD

NVivo can help you to:

 Manage your data & literature (to keep 
track of and store)

 Manage your ideas and keep a journal 
of the research process

 Ask interesting questions of your data

 Visualise your data, concepts, 
relationships

 Report from the data

Adapted from Bazeley and Jackson 
(2013: 3)
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• Navigate your way round NVivo

• Import text data into NVivo

• Code text data

• Make notes about your data

• Retrieve coded data using ‘queries’

• Float or stay above water…

Learning objectives -

Today you found out how to:



WHAT NEXT?
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Here are some other places on YouTube where you can 

go to find out more about NVivo, and the different 

functionalities. [The videos feature NVivo v12 but the 

principles are the same.] There are many introductory 

mini-lectures on key features of NVivo (qualitative data 

management software) – QSR International:

Please note: these URLs are case-sensitive

• Analysis with NVivo 12 for Windows: 

https://bit.ly/3fBnWq7

• Coding with NVivo 12 for Windows: 

https://bit.ly/3tZN5jC

• Importing data with NVivo 12 for Windows: 

https://bit.ly/3u6rUfC

• Tutorials for NVivo 12 for Mac:

• https://bit.ly/33Z6oPl

Click here to check 

out extra resources in 

the Workbook ☺

https://bit.ly/3fBnWq7
https://bit.ly/3tZN5jC
https://bit.ly/3u6rUfC
https://bit.ly/33Z6oPl
https://skills.it.ox.ac.uk/nvivo-walking-before-running-code-and-retrieve-course-pack


Please note: these URLs are case-sensitive

▪ QSR international have regular webinars and 
tutorials online: https://bit.ly/3fy7JCi

▪ University of Hull have developed online 
tutorials: https://bit.ly/3f4ZzCj

▪ QSR international have step-by-step 
instructions for  NVivo’s full functionality here 
(NVivo 1 for Windows Help System): 
https://bit.ly/3nxBnMU

▪ Download NVivo sample projects provided 
by QSR – search for ‘sample projects’ in 
NVivo Help online (or click here for Windows
and Mac)

If you know of any other helpful resources, 
please let us know 
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Click here to check 

out extra resources in 

the Workbook ☺

https://bit.ly/3fy7JCi
https://bit.ly/3f4ZzCj
https://bit.ly/3nxBnMU
https://help-nv.qsrinternational.com/20/win/Content/about-nvivo/explore-sample-project.htm
https://help-nv.qsrinternational.com/20/mac/Content/about-nvivo/explore-sample-project.htm
https://skills.it.ox.ac.uk/nvivo-walking-before-running-code-and-retrieve-course-pack


Thank you!

All the best with your research and 
adventures with NVivo ☺
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